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1.0  Introduction
The	UTM	is	a	versatile	tool	to	be	used	by	engineers	and	QA	departments.		The	UTM	can	be	used	to	fine	tune	a	new	
product,	monitor	quality	on	the	production	floor,	or	to	ensure	vendor	supplied	parts	meet	your	companies	specifications.

The UTM features an easy to use graphical interface, DDE capability for easy communication with spreadsheet based 
programs	like	Microsoft	Excel,	Excel	Templates	for	more	flexibility	if	you	prefer	Excel	over	the	UTM,	has	the	ability	to	
program	test	off-line,	long	file	name	capability,	and	now	communicates	with	our	Torque	Wrench	Tester	and	Torque	Wrench	
Calibration System.

The UTM communicates not only with the entire Larson family of testers but can communicate with any device that output 
simple ASCII data and can also accept information through the keyboard.

The	UTM	is	fully	backward	compatible	with	previous	revisions	and	can	even	read	data	files	from	our	older	STM	program.		
The UTM is compatible with Microsoft Windows 95, 98, NT and 2000.

2.0  Installation
The UTM comes on one CD-ROM.  Put the disk in your CD-ROM drive and 
run the Setup.exe program.  The UTM installer will not autostart.  The installer 
will display a path where it will install the UTM; you can change this path if 
you	like.		Once	you	are	satisfied	with	the	install	path,	continue	the	installation.

Once	the	installation	is	finished	you	will	have	a	new	Program	Group	called	
Larson Systems Inc. in the Programs item of the Start Button.  In the Larson 
Systems Inc. Program Group is the shortcut for the UTM.  Use this shortcut 
to launch the UTM program.
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3.0  Getting to know the UTM
3.1  Demo Programs
The UTM comes with 4 demo programs that you can use to familiarize yourself with the UTM.  These 4 demos are read-
ily available to you and are also used in the Interactive Demos that come with the UTM.  The interactive Demos can be 
accessed from the Run Demo menu within the main Options menu.  These demos will automatically load and display 
data showing different operations and views that the UTM can display.  These demos will explain different parts of the 
UTM.  This chapter will explain in more detail how to use the UTM.

3.2  Creating a Test
From the File menu select New.  The 
UTM	will	ask	you	to	confirm	that	you	
want	to	clear	out	all	specifications	and	
results.  Click OK to continue.

The Specifications Options will be 
shown with a completely blank test.  
From here you can choose the testing units you want to use, if you are using a compression or extension test (you can-
not mix compression and extension test points, all of the test points in a test will be either extension or compression), 
UT force and length maximums (these will be compared to all of the UT test parameters before being downloaded to 
a UT tester), and other various options for a UT tester.  When you have selected all of the options you want click OK.

By default the programming mode is UT Batch.  As long as you use UT tests the mode stays as UT Batch.  If you select 
any	non-UT	test	the	mode	will	be	switched	to	Interactive	and	you	will	receive	a	notification	to	this	effect.

You	can	change	from	UT	Batch	mode	to	Interactive	mode	without	selecting	an	Interactive	test.		Use	the	Specification	
Options (Section 3.2.2) to change the mode.

If you have a new test (no test points have been programmed) you can enter ST Batch mode either by selecting the 
Larson	ST/MST	command	from	the	Command	list	or	by	selecting	ST	Batch	Mode	from	the	Specification	Options.
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3.2.1  Test Specifications
When	the	Test	Specifications	window	is	not	shown	you	can	open	it	from	the	Specifications	menu	item	and	choosing	Test.

With this window you will program and view the entire test as well as choosing what test point results to display once 
results are gathered.  The UTM is capable of up to 99 test points.  To change from one test point to another either use 
the Up/Down arrows next to the Test Point text box or change the number in the text box using the keyboard.

In the top of this window is a box to enter a part number, this is optional.  This part number will appear on the printout 
and should be used for part description.  This display will be consistent for every test point.  It will also appear in the title 
bar of the UTM.

For each test point you must choose a command to be performed.  Different data will be needed for different commands 
and	the	layout	of	the	Test	Specification	window	will	change	according	to	the	command	chosen.		Some	commands	require	
a second window to setup the command, like the SDHT command.  All of the command will be explained in detail latter 
in this chapter.  Use the Command drop down list to select the test you want to perform.

If you a setting up a UT command you have the option of using Dynamic or Static speed.  Static speed is the default set-
ting for most UT commands and allows the UT to vary the platform speeds for optimum movement and precise platform 
placement during the test.  Dynamic test speeds force the UT to move the platform at one speed and will result in less 
precise	final	platform	resting	position.		The	UT	will	still	take	readings	at	the	desired	position	but	the	final	resting	position	
of the platform will not be at the programmed position.  The faster the speed is set to, the further the platform will be 
from the programmed position.

To use Dynamic Speed check the label “Dynamic” and enter a speed in in/min or mm/min depending on what units you 
have chosen for the test.  If the checkbox is left unchecked Static speeds are used.  The Dynamic checkbox is located 
to the right of the Command drop down list when Dynamic speeds are available.

For	UT	command	you	also	have	the	option	of	programming	in	Absolute	or	Incremental	specifications.		Absolute	specifica-
tions	represent	the	actual	length	or	force	you	want	the	tester	to	find,	such	as	3	inches	or	50	lb.		Incremental	specifications	
represent a force or length amount you want to add to the results from the last test.  Example, an incremental move of 2 
inches will make the tester move the platform in a positive direction a distance of 2 inches.  If the platform was sitting at 
5 inches the platform will then end up 7 inches.  Negative incremental values will cause the tester to move in the nega-
tive direction.  The result of an incremental test will be an incremental value, that is, the difference in force or length from 
where it was to where it ended up.

To program an incremental test check the box labeled “Inc”.  The label above this check box in “Abs/Inc”.  This box will 
be	to	the	left	of	the	force	or	length	specification	input	boxes	if	the	selected	command	allows	incremental	testing.

For each test point you can enter a comment.  This command is for the test point only and will appear with the test point 
on the printout.  Global comments will be discussed later.

For ease of programming there is a Delete Tp and an Insert Tp button available.  To completely remove a test point from 
the	test	sequence	use	the	Test	Point	arrows	to	find	the	unwanted	test	point	and	click	the	Delete	Tp	button.		This	will	
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remove the test point and move any test points above it down one to close the hole.

If you want to add a test point in the middle of a test use the Test Point arrows to go to the test point that will get moved 
forward and click the Insert Tp button.  The test point that you are on, and any tests above it, will get moved one ahead 
and a blank test point will be inserted into the new hole.

The end of the testing sequence is determined by a blank test point.  If you leave a blank test point in the middle of a 
test sequence the test will end earlier than you want it to.

Once you specify all of your tests use the built in checker to verify that there are no errors with the test.  The checker 
will check for things like lengths or forces that are too large, and illegal Rate test points.  The Check Point button is to 
the left of the part number label.

For each of the different UT commands different information such as forces, lengths, tolerances, rates, rate test points, 
or	speeds	will	be	entered.		The	next	section	will	describe	all	of	the	available	test	and	what	specification	you	are	expected	
to enter.

3.2.1.1  Command List
Testing commands fall into two types; UT tests and Interactive tests.  UT tests require a Larson UT be attached to the 
computer.  Before the UT can be used the RS232 communication port must be set up.  See Section 3.3.3, Setup Ports 
to do this.  Interactive test may or may not require an external device be connected.

Most	UT	tests	require	1	specified	number,	a	force	or	length	usually.		For	most	UT	tests	you	can	enter	nominal	and	toler-
ance	specifications.		If	you	enter	only	nominal	specification	and	not	tolerance	specifications	the	UTM	will	generate	a	
percentage	number	that	represents	the	difference	between	the	nominal	specification	and	the	result.		If	you	specify	both	
nominal	and	tolerance	specification	you	will	also	get	a	Bad	Low	/	Good	/	Bad	High	result.		If	even	one	test	point	has	a	
tolerance	specification	the	entire	test	will	have	a	Good	/	Bad	overall	result.		For	UT	tests	you	can	enter	the	tolerance	as	
either a percentage or as Upper and Lower limits.  The UT uses only nominal values and percentage tolerance.  If you 
enter Limits the UTM automatically calculates a nominal value and a percentage tolerance.  If you enter a nominal value 
and	a	percentage	tolerance	the	UTM	will	automatically	fill	in	the	Upper	and	Lower	Limits.

Most	Interactive	specifications	will	be	either	constants,	variables,	or	results	of	test	points.		A	constant	is	a	number	you	
specify.  As implied it never changes over the course of the test.  A variable can hold any number and, as implied, may 
vary	over	the	course	of	the	test.		Any	variable	used	must	be	named,	but	does	not	have	to	be	defined	in	the	beginning	of	
the	test,	its	first	appearance	can	be	anywhere	in	the	test.

Some interactive tests allow you to force units onto readings.  Units are used to make sense of some numbers and are 
displayed on the graphics and printouts..

3.2.1.1.1  Force At Length
This is a UT test.  You must specify a length for the UT to move to.  You can specify a nominal force and a tolerance, 
either	as	a	percentage	or	as	Upper	and	Lower	Specification	limits.

3.2.1.1.2  Length At Force
This is a UT test.  You must specify a force for the UT to move to.  You can specify a nominal length and a tolerance, 
either	as	a	percentage	or	as	a	Upper	and	Lower	Specification	limit

3.2.1.1.3  Preset
This is a UT test.  You must specify either a force or a length for the UT to move to, you cannot specify both.  You also 
must specify a number of times for the UTM to make this move.  Depending on what option you have purchased for the 
UT the maximum number of presets is either 99 or 999,999.  This test gives no results.

3.2.1.1.4  Free Length
This	is	a	UT	test.		It	will	only	be	performed	for	compression	type	tests.		No	forces	or	length	specifications	are	necessary.		
You	can	enter	a	nominal	length	and	tolerance,	either	as	a	percentage	or	as	Upper	and	Lower	Specification	limits.

3.2.1.1.5  Peak Force
This is a UT test.  You must specify a length for the UT to move to.  This test uses the Dynamic speed option, this means 
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that	the	tester	will	move	at	one	speed	until	it	reached	the	specified	length.		The	default	speed	is	15	in/min.		You	can	
change	this	speed	if	you	wish.		The	tester	will	monitor	the	force	while	moving	to	the	specified	length	and	will	store	the	
maximum	force	it	encounters.		The	tester	stops	monitoring	force	when	it	sees	the	specified	length	and	then	stops	the	
platform.		Because	this	test	uses	the	Dynamic	speed	the	platform	may	not	stop	at	the	specified	length	exactly,	there	
may	be	a	slight	over-travel.		The	faster	the	Static	speed	is	defined	as,	the	more	over-travel	there	will	be.	You	can	enter	
a nominal force and a tolerance, either as a percentage or as Upper and Lower limits.

3.2.1.1.6  Rate
This is a UT test.  You must enter two test points to calculate the rate between.  These test points must exist and must 
be	UT	test	points.		They	do	not	necessarily	have	to	be	defined	before	this	test	point,	i.e.	you	may	have	a	three	point	test	
where	the	first	is	a	rate	between	point	2	and	3	and	points	2	and	3	are	Force	at	Length	tests.		You	can	enter	a	nominal	
rate and a tolerance, either as a percentage or as Upper and Lower limits.

3.2.1.1.7  Pause
This is a UT test.  There are no values to specify.  This test will stop the testing sequence until a user presses the start 
buttons on the UT.

3.2.1.1.8  Delay
This	is	a	UT	test.		You	must	specify	and	amount	of	time	for	the	tester	to	be	inactive.		The	actual	time	value	is	defined	
as mm:ss.s (two digits for minutes, two digits for whole seconds, and 1 digits for tenths of a second).  However, you will 
enter the time as a 4 digit number in the form mmss.s.  The ones and tens place represent two digits for whole seconds.  
The hundreds and thousands places represent a two digit number for minutes.  The tenths place represent the tenths of 
a	second.		After	the	specified	amount	of	time	has	passed	the	tester	will	continue	with	the	testing	sequence.

3.2.1.1.9  Initial Tension
This is a UT test.  It is the last UT only test in the list.  It will only function for an extension type test.  You must specify a 
deflection	length.		This	length	is	used	to	slightly	pull	the	extension	part.		To	total	deflection	will	be	twice	what	you	enter.		
Care must be taken when entering this length to avoid damaging the part being tested.  A nominal force and tolerance 
can	be	specified,	either	as	a	percentage	or	by	Upper	and	Lower	Limits.

An	extension	test	consists	of	three	moves.		The	first	is	to	slightly	pull	on	the	part	until	it	is	snug	between	the	extension	
hooks;	a	very	minimal	amount	of	force	is	applied	to	do	this.		The	next	move	deflects	the	part	the	specified	length.		The	
tester	notes	and	remembers	the	resulting	force.		The	next	move	is	to	deflect	the	part	again	the	specified	length.		The	
resulting force is noted and remembered.  The two forces are put through a formula and the Initial Tension is the actual 
result.

3.2.1.1.10  If…Then Go To
This is an Interactive test.  This test will compare two speci-
fied	numbers	and	if	the	comparison	is	true	testing	control	is	
passed	to	a	specified	test	point.		If	the	comparison	is	false	
testing control is passed to the next test point.  The two 
specified	numbers	and	the	Go	To	test	point	can	be	either	
constants,	variables,	or	results	of	test	points.		Both	specified	
comparison numbers cannot be constants however.  Com-
paring two constants is a redundant task.  The comparison 
can be one of six functions; less than, greater than, equal, 
not equal, less than or equal to, or greater than or equal to.  
The result of this test point will be a number representing 
one of two test points, either the next consecutive point or 
the Go To test point.

3.2.1.1.11  Go To Testpoint
This is an Interactive test.  You must specify 1 number that 
represents where testing control will be passed to, i.e., 
what test point will be run after this one.  This number can 
be	specified	either	as	a	constant,	a	variable,	or	a	result	of	
another test point.  You can use this type of test point in 
conjunction with an If .. Then Go To test to form an If .. Then 
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.. Else structure.
3.2.1.1.12  Calculate 
Variable
This is an Interactive test.  
For this test you must specify 
one variable.  This variable 
will be set to the result of a 
function you enter.  The func-
tion can contain constants, 
other variables, the variable 
on the left side of the equal 
sign, and results of other 
test points.  The function can 
contain the operators plus(+), 
minus(-), multiply(*), divide(/), square root (Sqrt()), power (^), and embedded parentheses(()).  The result of this test 
will be the result of the function entered.  The result will also be stored in the variable on the left side of the equal sign.

3.2.1.1.13  Variable Tolerance
This is an Interactive test.  For this test you will 
specify three numbers.  The numbers can be con-
stants, variables, or results of test points.  You must 
specify a result value, a nominal value, and a toler-
ance	value.		The	tolerance	value	can	be	defined	
as a percentage (+/- X%) or as a whole number 
(+/- X units).  The result value will be compared to 
the nominal value and the difference between the 
two will be expressed as a percentage.  The difference will be compared to the tolerance and a Bad Low / Good / Bad 
High	result	will	be	generated.		The	result	of	this	test	will	be	the	result	value	that	was	specified.

3.2.1.1.14  Set Variable
This is an Interactive test.  For this test you will specify a variable name 
and a value.  There is no limit enforced for the variable names.  The value 
the variable is set to can be a constant, another variable, or the results 
of a test point.  The result of this test point will be what is entered in for 
the value with either a “C” if the value was a constant, a “V” if it was a 
variable, or an “R” if it was the result of a test point.

3.2.1.1.15  Read Keyboard
This is an Interactive test.  With this test you can 
prompt the user to input data from the keyboard.  
The data expected can be either text data or 
numerical data.  Numerical data can have a 
nominal	and	tolerance	specification	applied	to	it.		
For either type of data you can specify the prompt 
that the user sees when asked to enter data.  The 
nominal and tolerance numbers can be entered 
as constants, variables, or results of test points.  
Constant zeros will result in no tolerances being 
applied.  The tolerance number can be expressed 
as a percentage or as whole units.  You can also 
specify what units the entered data will have, force 
units,	length	units,	no	units,	or	user	defined	units.
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3.2.1.1.16  Read Serial Port
This is an Interactive test.  With this test 
you can bring in data from external devices 
that are connected to you computer.  You 
must specify what RS232 communication 
port the device is connected to.  If you do 
not know what port you are using consult 
your I.T. department or computer supplier.  
Be sure to enable the port with the correct 
communication protocols from the Port 
Setup menu (see section 3.3.3).  You must 
also specify a delineation for the device.  A 
delineation is a character that the external 
device sends out that signals the receiving 
device	(the	UTM)	that	it	is	finished	sending	
data.  Typical delineations are the carriage 
return, the line feed, or the tab character.  
A	delineation	could	also	be	a	specific	number	of	characters.		If	your	device	does	not	provide	any	delineation	you	may	
use	Delay.		If	Delay	is	used	for	a	delineation	the	UTM	will	wait	the	specified	number	of	seconds	after	it	receives	the	first	
character and then end the character gathering.  Whatever characters were sent within that amount of time is what it 
accepts for a result.  Check the owner’s manual of you device to verify what its delineation is.

You may also specify a nominal and tolerance value for the reading.  Both number can be either constants, variable, or 
results	of	other	test	points.		The	tolerance	can	be	specified	as	either	a	percentage	or	whole	units.		You	can	apply	units	to	
the	reading	also,	either	force	units,	length	units,	no	units,	or	user	defined	units.		The	result	of	this	test	point	is	whatever	
the external device sent over.

3.2.1.1.17  Testpoint Comments
This is an Interactive test.  This test allows information or in-
structions to be given to the person who is performing the test.  
There are two options when displaying these comments.  First 
is the option of having the user acknowledge these comments 
before the test will continue.   The user must acknowledge the 
comment before the test continues.  The second is to just have 
the	comment	displayed	until	 the	next	 test	point	has	finished	
gathering its data.  After displaying the comment the UTM pro-
ceeds with the next test.  The comments will be displayed until 
that	next	test	finishes.		The	person	performing	the	test	may	or	
may not see these comments for this second case.

3.2.1.1.18  Sorter Output
This is an Interactive test.  It does, however, necessitate the use of a Larson 
UT	tester.		A	sorting	signal	and	an	amount	of	time	must	be	specified	for	
this	test.		Both	specifications	can	be	either	constants,	variables,	or	results	
of other test points.  For this test the UTM will create a sort table with one 
condition and will formulate a one point test that will result in a true status 
for the one condition in the sort table.  This will result is the sorting signal 
specified	to	be	generated.		The	sorting	signal	will	last	for	the	specified	time	
interval.		The	result	of	this	test	will	be	the	sorting	signal	specified.
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3.2.1.1.19  Timer
This is an Interactive test.  The UTM contains a general purpose timer 
that runs off the computer’s clock.  It can count up or down and has a 
resolution of 1 tenth of a second.  The Timer test actually has 4 func-
tions.  All but one involve specifying a certain amount of time.  The 
amount	of	time	specified	can	be	entered	as	a	constant,	a	variable,	or	
the result of another test point.

The Stop Timer function does not specify an amount of time nor does 
it require knowing if the timer is moving up or down, it simply stops 
the timer if it is running.  The result of this function is the value of the 
timer when it was stopped.

For the Start Timer function you must specify if the timer is counting up or down.  The Timer can start with a time off-
set that you enter.  Starting with an offset of zero and counting up counts how much time has passed.  Starting with a 
nonzero	offset	and	counting	down	could	represent	an	amount	of	time	you	desire	the	test	to	finish	in.		The	result	of	this	
function is the value of the time offset.

The Set Timer function simply sets the time offset.  It does not need to know if the timer will be counting down or up.  
The	timer	does	not	start	or	stop	with	this	function.		It	will	reset	the	timer	to	the	specified	value	if	the	timer	is	running.		The	
result of this function is the time value that was set.

The	Wait	Until	Timer	Is	function	will	hold	up	testing	until	the	timer	becomes	the	specified	value.		If	the	timer	is	not	running	
it will start it.  It will override the direction of timing if the timer is running.  The result of this function is the value that the 
function waited for.

3.2.1.1.20  Larson TST
This is an Interactive test.  With this 
test you can get one piece of data 
from a Larson Torsion Spring Tester.  
The TST is capable of sending two or 
more pieces of data at once but, as 
stated, this test only reads one piece 
of data.  Multiple Larson TST tests can 
be programmed to receive all possible 
pieces of data sent from a TST.

This test can either wait for new data 
sent from a TST (by using the Send 
button on the tester) or it can use data 
that was sent over previously to this 
test point getting test control.  If you 
are looking for one piece of data only 
or	for	the	first	piece	of	multiple	pieces	
of data you would want to select Wait 
for TST Send Button Press..  If you are 
looking for the second or later pieces 
of data from a TST you would want to 
select Use Previously Send Data.

You must specify what RS232 communication port this test will be using because it is possible to connect more than 
one TST to you computer.
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Next you must specify what piece of data you want to capture.  The TST is capable of having 4 different testing modes; 
Manual, Peak, First Peak, and Two Point with Rate modes.  For Manual, Peak, and First Peak modes are capable of 
generating	two	pieces	of	information;	torque	and	angle.		The	Two	Point	with	Rate	mode	generates	five	pieces	of	data;	
two sets of torque/angle readings and a Rate.  You must choose what piece of information you wish to capture.  If you 
want	both	or	all	five	you	must	have	either	two	or	five	Larson	TST	tests	defined.		The	first	defined	test	point	should	always	
have	the	Wait	For	TST	Send	Button	Press	button	selected.		The	second	or	second,	third,	fourth,	and	fifth	defined	tests	
point should always have the Use Previously Send Data button selected.  Each test point should have a different torque 
or angle selection selected.

For each torque or angle reading you can specify a nominal and tolerance to apply to the data from the TST.  The toler-
ance	can	be	specified	as	either	a	percentage	or	as	whole	units.		The	units	of	the	result	will	be	either	torque	or	angle	units.

3.2.1.1.21  Larson Super DHT
The Larson Super DHT is similar to the 
Larson TST as far as the setup.  The 
Larson	Super	DHT	is	capable	of	five	
testing modes; Manual, Peak, First 
Peak, Switch Contact, and Two Point 
with Rate modes.  Manual, Peak, and 
First Peak modes can generate 2 read-
ings, Two Point mode can generate 5 
readings and Switch Contact mode 
can generate 9 readings.  If you want 
to capture all of the data for the Mode 
you are testing in you must have 1 
test point for each reading.  For each 
test	point	defined	you	should	select	a	
different reading.

If the test point is capturing only 1 read-
ing	or	the	first	of	multiple	readings	from	
a Super DHT send you should select 
the Wait for SDHT Send Button Press.  If the test point is capturing the second or successive readings from a SDHT 
send you should select Use Previously Send Data selection.

For each reading captured you can specify a nominal and tolerance to apply to the data from the SDHT.  The tolerance 
can	be	specified	as	either	a	percentage	or	as	whole	units.		The	units	of	the	result	will	be	either	force	or	length	units.

3.2.1.1.22  Larson ST/MST
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This is the ST Batch Mode test.  From this test you can communicate with Larson’s older ST and MST machines.  This 

test point includes all the programming options available for the ST machines.

To start, the ST can be set to run in 1 of 4 modes.  Two point, Multi point, Free Length/Solid Height, and Force Preload.  
Two point mode allows only two points to be programmed.  The Rate is automatically calculated and the tolerance speci-
fied	is	applied		to	both	points	and	the	Rate.		Multi	point	mode	has	a	maximum	of	10	point	to	program.		Each	point	can	
have a different tolerance and the Rate can be calculated between any 2 points.  The Rate tolerance is also separate 
from	the	test	point	tolerances.		Free	Length/Solid	Height	mode	allows	you	to	define	a	force	for	both	Free	Length	and	
Solid height and allows for two testing points between the two.  The same tolerance will be applied to both test point and 
the rate.  The Rate is calculated between the two middle testing points.  The Force Preload mode allows you to specify 
a	force	for	the	tester	to	move	to	and	then	to	deflect	a	certain	amount	of	length	from	where	the	force	was	found.		Those	
are the only two points to the Force Preload test.

As stated above each of the testing modes has at least two points to specify.  You can use the Test Point arrows and 
text	box	in	the	ST	window	itself,	there	is	no	need	to	use	the	Test	Point	arrows	and	text	box	on	the	Test	Specifications	
window.  The ST setup window is fully self contained.

Two point and Multi point modes allow testing in either compression or extension mode.  Free Length/Solid Height and 
Force Preload only allow for compression testing.

There are four sets of units to select from, one Standard (inch/pound) and three metric (Newtons, grams, or kilograms 
force with millimeters length).

You should know what version code your tester is running.  Code versions were broken into three categories; version 
up to 12.0, version 12.1 to 12.5, and version 12.6 and later.  If you do not know for sure what version your tester is run-
ning	a	system	of	trial	and	error	with	the	three	selections	should	let	you	find	out	what	group	of	version	you	are	running.

By entering any force and count in the Preset space the ST will perform a Preset operation before the tester performs 
the actual testing commands.

Depending	on	what	type	of	test	you	are	performing	the	Length/Height	specification	section	will	reformat	and	relabel	itself	
to	prompt	you	to	enter	the	specification	you	wish.	

For	Force	At	Length	tests	the	first	number	you	will	enter	is	the	testing	length.		You	can	then	enter	the	nominal	force	value	
and percentage tolerance or you can enter the upper and lower force limits.  For Length At Force tests you will enter 
a testing force and the nominal length and tolerance or upper and lower length limits.  For Two Point tests the Rate is 
calculated automatically and cannot be changed.  For Multi point tests the Rate is calculated automatically but you can 
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change it to whatever you want.

The	Free	Length/Solid	Height	is	performed	in	compression	mode	only.		You	will	first	be	prompted	to	provide	a	force	that	
will	be	used	to	find	the	free	length.		This	should	be	something	small,	between	0.1	and	0.5	lb.		You	will	then	enter	speci-
fication	for	2	Force	At	Length	points.		Finally	you	will	enter	a	force	to	be	used	for	Solid	Height.		This	should	be	a	force	
that is less than full scale and is enough to completely compress the part but not enough to damage the part.  The Rate 
is automatically calculated from the two Force At Length points but you can change it to whatever you want.

The Force Preload test consists of two points.  First you will enter a force to load the spring to.  Then you will enter a 
deflection	for	the	length;	this	is	an	amount	of	length	to	move	from	where	the	force	was	found.		It	is	an	incremental	move.		
The	result	will	be	the	difference	between	the	final	force	and	the	preload	force;	this	is	an	incremental	result.		There	is	no	
rate to calculate or enter.

3.2.1.1.23  Larson DHT/FDHT/CDHT/ECT
This command is used to receive information from any of the Larson DHT line of testers except for the Super DHT, it 
has its own command.  The FDHT only sends out Force.  The other DHT testers can send out both Force and Length 
data.  You can optionally enter a nominal value and tolerance for the data you want to receive.  If the tolerance value 
is left as a zero no condition (Bad Low, Good, Bad High) is generated.  If the Nominal value is left a zero no resultant 
tolerance is calculated.  The serial port the tester is connected to must be selected here.

When	receiving	the	first	piece	of	information	from	either	tester	the	“Wait	for	DHT	“Send”	Button	Press”	option	must	be	
set.  This will force the UTM to wait until the operator has sent information from the tester.

If both Force and Length information is to be received two separate Larson DHT/CDHT commands (test points) must 
be	set	up.		The	first	command	must	have	the	option	“Wait	for	DHT	‘Send’	Button	Press”	set.		The	second	DHT/CDHT	
command must have the option “Use Previously Sent Data” set.  This will allow the second command to use the same 
information	that	the	first	command	used.

                                    First Command                                                        Second Command
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3.2.1.1.25  Larson Super TWCS
The Larson Super TWCS is similar to the Larson TWCS in that is only sends Torque data.  However, the Super TWCS 
can test in three different modes ; Manual, Peak, and First Peak.  These mode are useful for testing the different types 
of torque wrenches.  You can optionally specify a nominal and tolerance value for the torque data being received.  A 
zero	in	the	tolerance	specification	results	in	not	Bad	Hi/Satisfactory/Bad	Low	results	being	calculated.		A	zero	for	the	
nominal	specification	results	in	no	resultant	tolerance	being	calculated.		You	must	specify	what	serial	port	the	Super	
TWCS is connected to.

3.2.1.1.24  Larson TWCS
The Larson TWCS only sends torque.  You can set a nominal torque and tolerance for the reading. The tolerance can 
be	specified	as	a	percentage	or	as	whole	units.		A	zero	in	the	tolerance	specification	results	in	not	Bad	Hi/Satisfactory/
Bad	Low	results	being	calculated.		A	zero	for	the	nominal	specification	results	in	no	resultant	tolerance	being	calculated.	
You must select what serial port the TWCS is connected to.
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3.2.1.1.26  End Test
This command can end a testing sequence prior to the last test point.  It can be used in conjunction with the If .. Then 
Go To and Go To test points to provide for conditional testing and conditional ending of the test.



3.2.2.1  Programming Mode
Open	the	Specifications	Options	by	clicking	on	the	Specifications	menu	and	choosing	Options.	 	From	here	you	can	
change testing units or UT tester force and length maximums and select different UT options.

There are three Programming Modes: Interactive, UT Batch, and ST Batch.  In the UT Batch programming mode only 
the UT commands can be used.  If any other commands are selected the Programming Mode will automatically be set 
to Interactive.  You can revert back to UT Batch mode by removing the Interactive Mode command and selecting UT 
Batch from here.

When performing a test in UT Batch mode all of the test points will be downloaded to a UT at once.  A user will then start 
the	UT	manually	(consult	the	UT	users	manual	for	this	operation).		When	the	UT	is	finished	testing	all	of	the	test	points	
the results will be uploaded to the UTM and ready for viewing.

When performing an Interactive test each test point will be performed one at a time.  If there are UT commands in the 
test each test will be performed one at a time.  The test point will be downloaded, the UTM will AUTOMATICALLY initiate 
the UT test, the result will be uploaded to the UTM and the UTM will proceed to with the next test point.

The ST Batch mode is similar to the UT Batch mode except that the ST/MST command is used.  The ST/MST command 
will open a second setup window and from the second window you can program up to 10 ST test points.  If any other 
commands are chosen while in ST Batch mode, the mode will be switch to Interactive Mode.
  

3.2.2.2  Units
By	changing	the	force	and	length	units	the	UT	force	and	length	maximums	will	change	to	reflect	the	chosen	units.		The	
Torsional and Angle units are used for the TST and the TWCS commands.
3.2.2.3  Spring Type
Select what type of parts to test, compression or extension.  If you select Extension you can select to synchronize the 

3.2.2  Specification Options
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Length Offset with the UT.  In newer version of the UT tester (control software 30.79 or higher) the Extension Initial-
ization Offset can be set by the operator.  The Extension Initialization Offset is entered into the Length Offset.  If you 
use the UTM to download an extension test to a UT, it may change the Length Offset.  Use the Synchronize Option 
to avoid changing the Length Offset.  When using the Synchronize option the UT must be in Extension mode to begin 
downloading the Extension test.

3.2.2.4  Verify Download Option
The	Verify	Download	option	is	necessary	for	some	older	UT	testers.		For	these	older	tester	it	is	necessary	to	confirm	
that	the	download	was	correct	so	this	option	will	force	the	UT	to	confirm	the	download	was	correct	by	uploading	the	test	
information back to the UTM.  This is done automatically, transparent to the user.

3.2.2.5  Working Limits
If	your	UT	tester	is	running	code	version	30.80	or	higher	you	have	the	ability	to	set	Working	Limits.		Working	limits	define	
a height range where the platform can be.  If the platform tries to move outside these limits at any time the platform will 
stop and an error will be generated.  Consult your UT Users Manual (060-1000-0029-00) for further information about 
Working Limits.

3.2.2.6  UT Option 1
After each test on a UT is performed information is displayed.  With Option 1 you can control what exactly is displayed, 
the results of the test just performed, test counts only, or the results from a certain test point.

3.2.2.7  UT Option 2
When Option 2 is disabled the platform will return to the place it was before the test started.  If Option 2 is enabled, 
wherever the platform came to rest at after the last test point is where the platform stays. 

3.2.2.8  UT Options 3, 4, and 6
Options 3, 4, and 6 are available for UT testers running code version 30.77 or above.

3.2.2.8.1  UT Option 3
Option 3 will force the UT to return to platform to its starting position if the tester overloads during a test.  This option is 
useful in an automation environment where parts are automatically moved onto and off of the testing platform.

3.2.2.8.2  UT Option 4
Option 4 is used to end a testing sequence early if any conditional test returns a Bad condition.  This option is useful if 
the testing sequence is extensive and only Good test results are acceptable.  Why continue testing a part if it is deter-
mined to be bad early on?

3.2.2.8.3  UT Option 6
Option 6 is used to apply multiple condition on a single force/length result.  For each test point a single condition is ap-
plied.  By setting multiple, consecutive test points to the same force/length position but with different conditions you can 
test one set of force/length readings to multiple conditions.  If Option 6 is disabled the UT will try to move to each force/
length position.  Each test point will then go through a positioning routine and take force/length readings for each point.  All 
of this takes time.  If Option 6 is enabled the UT will catch these identical, consecutive test points and will not go through 
the	motion/reading	routines	but	will	copy	the	force/length	results	of	the	first	test	point	into	the	identical	points	and	apply	
the different conditions to that copy.  By eliminating the motion/reading parts, noticeable amounts of time will be saved.

3.2.3  Sorting
The UT testers are equipped to give out sorting signals in a stand-alone fashion.  Sorting is enabled for UT Batch Mode 
only.  It is disabled for ST and Interactive mode. 

To	do	this	a	sorting	table	must	be	entered.		To	see	the	sorting	table	select	the	Specifications	menu	item	and	the	choose	
Sorting.

Sorting is based on a three way sort.  A part can be sorted to the left, to the right, or straight down.  5 and 7  way sorts 
can be achieved by stacking 3 way sorters on top of each other providing 2 or 3 to the right, 2 or 3 to the left and one 
straight down.  Each left or right sort is controlled by a moving Flap.  Each Flap is controlled by one output from the UT.  
These Flap signals do not necessarily have to go to a 3, 5, or 7 way sorter but are available to any external device, such 
as an automation PLC.  It is also not necessary for these signals to go outside of the tester; the sort result is displayed 
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on the tester itself after a test.  This is useful for hand sorting.  The Sort 
Table setup screen is designed around the 3, 5, and 7 way sorter situation 
but again, the Flap signals can be use for anything.

The sorting table is limited to 50 lines.  Each line can be either a condition 
line	or	it	can	be	an	Open	Flap	line.		The	end	of	the	table	is	signified	by	a	
blank line.  If there is a blank line in the middle of a table, the bottom half 
will never be used for sorting operations.  When the UT uses the Sort Table 
it starts from line one and searches each line until either a true condition is 
met or until it sees the end of the table.  Once a true condition is met the UT 
stops searching the Sort Table and continues with normal testing.

Multiple condition can be put in consecutive lines to form an AND type condi-
tion structure.  In this case all of the condition lines 
must be true for the Open Flap line to be started. 
Multiple	flap	signals	can	be	generated	from	one	
Open Flap line if so desired.

To set up a line either double click a line in the 
table or click once on the line to select it and click 
the Change button.  This will bring up the Change 
Sort window.  From here you can set a condition 
on a single test point or set the line to open a Flap.  
If multiple Flaps are desired the Flap Combination 
button must be selected.  Once you have set up 
either the condition or the Flap Output click the 
OK button to return to the Sort Table.

There are 3 options for sorting.  To see these 
options click the Options buttons from the Sort 
Table window. 

Option	101	specifies	what	Flap	to	open	if	no	condi-
tions are found to be true.  By default no Flap will 
be opened.  You have to option of opening any 
Flap if no conditions are true.

Option 102 controls an ejection, or sweep, signal.  An air cylinder 
can be mounted on a UT that will automatically push a part off 
of the testing platform.  The sweep signal to start the air cylinder 
is	generated	after	the	testing	is	finished	an	when	the	platform	
returns to its starting position.  This is to make sure the part is not 
under pressure when the air cylinder starts moving.  With Option 
102 enabled this signal is generated.  If Option 102 is disabled 
this signal is not generated.

Option 103 controls the duration of the Flap signals.  By default 
the duration is 1 second.  You can increase or decrease this 
delay.  You can also use this option do disable the Flap signals 
and just let the sort result be displayed on the UT display, this is 
useful for manual sorting.  The Flap signals can also be made to 
stay on until either the next test is started or until the next Flap 
signal is generated.  These two types of actions should be used 
with care.  Having the Flap signals on too long may damage the 
external equipment if the equipment is recommended for only 
short term use.
3.2.4  Global Comments
If	there	are	any	comments	or	notes	you	wish	to	attach	to	the	overall	test	sequence	you	can	enter	then	in	the	Specification	
Comments.		To	view	these	comments	select	the	menu	item	Specifications	then	select	Comments.		Any	text	you	enter	
here	will	be	on	the	specification	printout.		Once	you	open	the	Global	Comments	window	you	will	have	a	Cut/Copy/Past	
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button appear in the button bar.  With these buttons you 
can easily retrieve you comments from other applications, 
like	a	word	processor.		When	you	finish	entering	your	com-
ments click OK.

3.2.5  Saving the test.
Once	you	have	finished	entering	in	all	of	your	test	speci-
fications	you	should	save	the	test.		To	do	this	either	click	
the save button in the button bar (the button with an arrow 
pointing	to	a	floppy	disk)	or	select	the	Save	item	from	the	
File menu item.  From the Save As window you can select 
what directory to place the test and create a test name.

If you try to alter a test that was loaded from a disk you 
will	receive	a	warning	about	that	file	being	altered	was	
loaded	from	memory.		If	you	do	wish	to	alter	the	file	you	
will	have	to	clear	out	the	file	name	and	any	results	that	
are	currently	in	the	UTM’s	memory.		The	specifications	
will	remain.		When	you	finish	altering	the	specifications	
you	can	overwrite	an	existing	specification	file.		If	the	
specification	file	has	results	associated	with	it	the	results	
may become unusable.  Be careful about overwriting 
specification	files!

3.3  Options
3.3.1  File Options.
When you go to save results that have been collected 
there are two ways to save them, either in a Larson 
Systems standard or in a dBaseIII format.  To select 
what format select the menu item Options and then 
select File Defaults.
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The	Larson	Systems	standard	is	an	ASCII	text,	comma	delineated	text	file	able	to	be	read	from	any	text	file	viewer	(Note	
Pad,	Word	Pad,	Microsoft	Word,	etc.).		This	file	can	also	be	easily	read	into	Microsoft	Excel	if	you	wish	further	analysis	
beyond the UTM capabilities. 

If you have a dBase program and wish to view the results in that use the File Options to set up how the numerical results 
are	formatted	in	the	result	file.

3.3.2  Result Options
These sets of options control how results are displayed on the monitor and on a printout.  To change these options from 
the Options menu item select Results.

The UTM has two ways of viewing results, either individually or in a Lot.  When viewing individual results you can see the 
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results of every test point for every test.  When viewing by Lot a number of consecutive tests are grouped together and the 
average for each test point 
is displayed.  The UTM is 
capable of loading multiple 
result	files.		With	this	feature	
you can see many hours, 
days, or months of tests at 
one time.  When viewing 
results by Lot all of the result 
files loaded into memory 
are grouped together.  This 
means that if the number of 
results	per	result	files	is	not	
even, a Lot results may in-
clude individual results from 
different	result	files.

From the Result Options 
you can control how many 
individual tests are grouped 
into a Lot by changing the 
Lot Size option.   The other 
options below Lot size controls how many Lots are displayed on the various graphical Lot results.

For all of the graphical results the data is represented by points on a graph connected by lines.  The points and lines 
have two sizes, large or small.  Use the Thick Lines and Big Symbols options to choose the line and point sizes.

You can use the Printer Orientation option here to specify how the graphs are printed out, either Portrait or Landscape.  
This orientation is separate from the orientation for text data printout.  Text data orientation is controlled from the Printer 
Setup, which is under the File menu.

The background color of the graphs can be controlled from here.  If you have a preference for graph colors you can 
change and preview each color from here.  To save toner or ink in your printer it is better to set the background to white, 
this way no toner or ink will be used for the background.

With the “Changes in Lot Results display also change Individual Results Display” enabled anytime you view different lot 
results	the	Individual	Results	display	will	change	to	reflect	the	first	individual	results	in	the	group	of	Lot	data.

With the “Changes in Individual Results display also change Lot Results display” option enabled, changing the Individual 
Results to different tests will cause the Lot Results display or any graphical Lot Results to change so that the last lot 
displayed is the Lot that the Individual Results display is in, i.e. if the Lot Size is 5 and the Individual Results display is 
showing the result for test 13, Lot 3 is displayed in the Lot Results displayed and the graphs show Lots 1 to 3.

With the “Keep Display Up-to-Date” option enabled any new results sent to the UTM will automatically be displayed in 
the Results display and in any graphs that are displayed.  This new data will be displayed in the Individual Actual display 
and the last Lot will be displayed in the Lot Actual data.

With the Results Printout Setup section you can select what else besides results is printed out for each test.  By remov-
ing certain features you can increase the number of test points per line up to a maximum of 8 results.  Tagged results 
are results that a user had determined should not belong in any of the statistical or graphical calculations.  From here 
you have to option to display the tagged results or not.

When you have selected all of the options you want click on the OK button to close the window.

3.3.3  Setup Ports
For	any	external	device	that	is	connected	to	your	computer	you	have	to	define	that	port	in	the	UTM	and	enable	it	before	
you	can	get	information	from	that	device.		To	define	the	port,	open	the	Setup	Ports	from	the	Option	menu	item.		The	
UTM can handle up to 10 serial ports.  If your computer does not have that many ports and you try to enable one that 
does not exist the UTM will generate a warning. 
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Use the Up/Down arrows or the text box 
to select the different ports.  For each 
port you can give a short description in 
the Port Comments box.  Each of the dif-
ferent Larson devices listed in the Device 
Type list will change the protocols to a 
preset setting.  These preset setting are 
unalterable.  If you are using a device that 
is not from Larson Systems you will have t o 
use the Other device type and set the var-
ious protocols setting to the appropriate 
settings.  Check with your device manual for 
the correct protocol settings.

Once all of the ports are set click 
the OK but ton to  f in ish set t ing up 
the ports and close the window.  If a 
warning is displayed that the port cannot 
be used it is usually because another de-
vice already has control of the serial port o r 
the serial port does not exist in your computer.  If you have problems like this consult your I.T. department or computer 
supplier.

3.3.4  Data Exchange
The UTM is capable of sending information directly to other programs by using either Dynamic Data Exchange or by a 
process of Keystroke Imitation called Send Keys.  It is also capable of receiving test setup commands using DDE.  Select 
what type of communication you will be using to send information from the Communication Type selections.
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3.3.4.1 Transfer Setup
Once you have gone through a DDE setup you can 
save that setup for future reference.  You can select 
saved setups using the dropdown list.  The UTM 
will remember the last Transfer Setup selected.  If 
no Transfer Setups have been added the UTM will 
remember each individual Data Exchange Setup 
settings.  The UTM has the ability to dynamically 
receive test information from another program.  This 
ability must be enabled here.  If this ability is enabled 
and not corresponding program is running the DDE 
link will fail and error messages will be generated.

3.3.4.2 Communication Type
Here you can select what communication method 
is used to send results out.  When selecting DDE 
you will have the ability to load a test from a spread-
sheet also.

3.3.4.3 Action Performed
From here you can select what action will be per-
formed with the action button on the bottom of the 
setup window.  Send Results will cause result data 
to be sent to the spread sheet.  Send Test will cause 
the	 current	Test	Specifications	 to	 be	 sent	 to	 the	
spread sheet.  Send Demo Test will cause a demo 
test to be sent to the spreadsheet.  The demo test 
will show how a test can be set up in a spreadsheet 
for loading later.  Load Test will cause a test to be 
loaded from the spreadsheet.  This is only avail-
able when using DDE communication type.  Alter 
Macros	will	cause	the	Macro	Definition	window	to	
open.  When using either communication method,  it 
is necessary to tell the spreadsheet when to change 
the selected cell and what cell to be the selected cell.  
This is done by setting Pre- and Post-Amble Macros.  
Pre-Amble macros will be send before the result data.  
Post-Amble Macros will be sent after the results data.  
Macros are comprised of keystrokes such Left, Right, 
Tab, or Enter.  Alpha-Numeric keystrokes can also be 
added.  For each piece of result data (Test Number, 
Data, Time, etc) you can enter a different Macro.

3.3.4.4 Spread Sheet Program Setup
When sending data to a spreadsheet the UTM will 
first	look	to	see	if	the	spreadsheet	is	running.		If	it	is	
not, the UTM will try to start it.  The Spread Sheet 
Program contains the full path to your spreadsheet.  It is a drop down list that will contain previous program paths that 
have been added.  If there are no paths that can be used you can create a new path by clicking on the Browse button 
below the Sheet Name text box.  This will allow you to select a new spreadsheet program and path.  The UTM also 
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need to know the title of the spread sheet.  The title is usually the program name and can be found on the very top of the 
program window.  The typical title for Excel is “Microsoft Excel.”  The UTM will also need to know what sheet the data 
will be sent to.  In Excel the sheet names are typically on the bottom of the sheet in a tab-type list.

Once you have entered the Spread Sheet Program and path, the Spread Sheet Title and the Sheet Name you can save 
these three items by clicking on the Add button.  This will result in a new item in the Spread Sheet Program drop down 
list.  You can use the Delete button to remove these three pieces of information for the setup that is shown.  You can use 
the Spread Sheet Program drop down list to select different  setups to use or delete.

3.3.4.5 Result Data Check List
You can pick and choose what Result Data to be sent by checking or un-checking the individual result types.
 
3.3.4.6 DDE Link Setup
DDE can be used to send Result data to a spreadsheet and also to dynamically load test information.  The cell where 
result information is sent to is set in the “Cell to start sending to” text box.  It should be formatted in “A1” format (Columns 
represent by a letter and rows represented by numbers).  When using DDE to load test data dynamically the UTM will 
look	at	one	spreadsheet	cell	and	will	look	for	a	change	in	the	data	in	that	cell.		The	cell	that	is	used	is	defined	in	the	“Cell	
to receive from” text box.  Again, it uses “A1” formatting.

The UTM can hold multiple sets of results in memory at once.  When the results are sent to a spreadsheet either the 
Active Set or All Sets can be sent by selecting the setting .  Result data can also be sent as it comes in, or “On The Fly”

3.3.4.7 Action Buttons
The left button will begin either a result Send or a test Load when clicked.  Use the close button to exit Data Exchange 
Setup.

3.3.4.8 Using DDE to dynamically program a test.
The UTM is capable of bi-directional communication with a spread sheet by using Dynamic Data Exchange.  Within 
the UTM Data Exchange setup the user can select a cell in the spreadsheet will be used for DDE dynamic test loading.  
This	link	to	this	cell	will	try	to	be	established	when	the	UTM	is	first	started,	when	the	Data	Exchange	option	is	opened,	
when the communication type is changed from Send Keys to DDE, and when the Receive From text box is changed.  
The	label	above	the	Receive	From	text	box	in	the	DDE	Link	section	will	reflect	the	status	of	the	link.

Once this link has been established it is possible for the spreadsheet to program a UTM test.  The commands that the 
spreadsheet has available to send to UTM are listed below with an explanation and the proper syntax.  To send a com-
mand to UTM simply enter the command in the proper syntax into the cell.   The UTM will change the text in the cell to 
the	text	“OK”	when	it	is	finished	processing	the	command	sent	over.		Commands	are	separated	from	the	data	with	a	“|”	
(the	“pipe”	character).		The	“|”	is	needed	even	if	the	command	to	be	sent	does	not	have	data.

3.3.4.8.1  Available Commands
1)  Test Point
	 This	command	allows	the	user	to	select	what	test	point	will	receive	information.		The	syntax	is	“TP|x”	where	x	is	a	

number from 1 to 99.
2)  Memory Clear
	 This	command	will	clear	all	specifications	and	results.		The	syntax	is	“MR0|”
3)  Specified	Length
	 This	command	will	change	the	specified	length	for	the	selected	test	point.		Some	commands	use	the	specified	length	

entries for other things than a length measurements.  For instance, the Rate command uses the length and force 
entries	for	the	first	and	second	test	point	used	in	the	rate	calculation.		The	syntax	is	“SL|x.xx”	where	x.xx	is	a	length	
value.  A decimal point is not necessary.

4) Specified	Force
	 This	command	will	change	the	specified	force	for	the	selected	test	point.		Some	commands	use	the	specified	force	

entry for other things than a force measurement.  For instance, the Rate command uses the force and length entries 
for	the	first	and	second	test	points	used	in	the	rate	calculation.		The	syntax	is	“SF|x.xx”	where	x.xx	is	a	force	value.		
A decimal point is not necessary.

5)  Specified	Tolerance
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	 This	command	will	change	the	specified	tolerance	for	the	selected	test	point.		The	syntax	in	“ST|x.x”.		The	decimal	
point is not necessary.

6)  Specified	Speed
	 This	command	will	change	the	specified	speed	for	the	test	point.		The	syntax	in	“SS|x.x”.		The	decimal	point	is	not	

necessary.
7) Specified	Incremental	or	Absolute	Test
	 This	command	will	change	the	measuring	convention	to	either	incremental	or	absolute	for	the	specified	test	point.		

The	syntax	is	“SI|I”	for	incremental	or	“SI|A”	for	absolute.
8) Specified	Miscellaneous
 This command will change the miscellaneous entry for the selected test point.  Command like Rate use the miscel-

laneous	entry	to	store	information.		The	syntax	in	“SM|x.x”.		The	decimal	point	is	not	necessary.
9) Specified	Comments
	 This	command	will	change	the	comments	for	the	selected	test	point.		The	syntax	is	“SO|xxx”.		The	data	for	this	

command is strictly text although number can be entered.
10) Specified	Part	Number
	 This	command	will	change	the	Part	Number	for	the	entire	test.		The	syntax	in	“SP|xxx”.		The	data	for	this	command	

is strictly text although number can be entered.
11) Specified	Command
	 This	command	will	change	the	command	for	the	test	point	(F@L,	L@F,	etc).		The	syntax	in	“SC|x”	where	x	is	a	letter	

that represents a command.  The list and explanation for the letters are in section 3.3.4.8.2.
12) Specified	Length	and	Force	Units
	 This	command	will	specify	Length	and	Force	units	for	the	test.		The	syntax	is	“MU|XY”	where	X	is	the	representation	

for Length units and Y is the representation for Force units.  The length units available are “I” for inches and “M” for 
millimeters.  The force units are “L” for lbs., “N” for Newtons, “G” for grams, “K” for kilograms, and “O” for ounces. 

13) Testing Direction
	 This	command	will	set	the	testing	direction	to	either	Compression	or	Extension	Testing.		The	syntax	is	“GE|X”	where	

X will be either “C” for compression testing or “E” for extension testing.
14) Length Offset
	 This	command	will	set	the	Length	Offset	for	the	test.		The	syntax	is	“GL|x.x”	where	x.x	is	the	Length	offset	desired.
15) Force Offset
	 This	command	will	set	the	Force	Offset	for	the	test.		The	syntax	is	“GF|x.x”	where	x.x	is	the	Force	Offset	desired.
16) Synchronize Extension Length Offset
	 This	command	will	set	the	Synchronize	option	for	Extension	Tests.		The	syntax	is	“GS|x”	where	“x”	is	either	0	for	no	

synchronization or 1 to synchronize.
17) Download Test to Tester
	 This	command	will	make	the	UTM	download	the	programmed	test	to	a	UT.		If	there	is	one	UT	com	port	defined	in	

the	UTM	the	test	will	be	download	through	that	com	port.		If	there	are	more	than	one	UT	com	ports	defined	this	
command	will	allow	you	to	select	which	port	will	be	used.		The	syntax	is	“DNLD|x”	where	x	is	the	com	port	that	will	
be	used	if	more	than	one	com	port	is	defined	as	a	UT	port.

18) Load a Test from the Hard Drive
	 This	command	will	make	the	UT	load	a	test	from	the	hard	drive.		The	drive	specified	can	be	either	a	local	drive	on	

the	computer	or	it	can	be	a	mapped	network	drive.		The	syntax	is	“LOAD|xxxx”	where	xxxx	is	a	proper	path	and	
filename	for	an	existing	UTM	specification	file.		The	proper	path	and	filename	should	be	in	the	form	“DRIVE	LETTER:\
FOLDER\SUBFOLDER\FILENAME.us1”.		An	example	would	be	“C:\Customer_X\Part_B\Build_2\Test_1.us1”

3.3.4.8.2  UT Commands available for Specified Commands
The UTM has 25 commands available for programming.  Only 9 can be use to program a UT Batch Mode test.  A UT 
Batch Mode test is a type of test that, once downloaded, requires no interaction with the UTM program.  The other type 
of testing is called Interactive Mode.  This mode required direct interaction with the UTM to complete the test.  In order 
to use Excel with the minimum amount of interaction with the UTM only UT Batch Mode tests should be used.

The	following	list	will	explain	what	data	is	needed	for	the	Specified	Command	and	also	what	other	command	the	test	
point	can	except.		All	of	the	specification	command	are	not	necessary,	such	as	testing	speed	or	tolerances,	and	will	be	
listed as optional.

3.3.4.8.2.1 UT Batch Mode commands.
1) Force at Length
	 This	command	is	represented	by	the	letter	“L”.		Testing	length	is	defined	in	Specified	Length,	optional	nominal	Force	

is	defined	in	Specified	Force,	optional	tolerances	are	defined	in	Specified	Tolerance,	and		optional	testing	speed	is	
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defined	in	Specified	Speed.		This	test	can	also	be	done	in	either	Absolute	or		Incremental	convention,	optional	and	
defaulted to Absolute.

2) Length at Force
	 This	command	is	represented	by	the	letter	“F”.		Testing	force	is	defined	in	Specified	Force,	optional	nominal	length	

is	defined	in	Specified	Length,	optional	tolerances	are	defined	in	Specified	Tolerance	and	optional	testing	speed	
is	defined	in	Testing	Speed.		This	test	can	also	be	done	in	either	Absolute	or	Incremental	convention,	optional	and	
defaulted to Absolute.

3) Preset
	 This	command	is	represented	by	the	letter	“P”.		This	can	accept	either	a	Specified	Length	or	a	Specified	Force	to	

preset	to	but	cannot	accept	both.		The	number	of	presets	to	perform	is	defined	in	Specified	Miscellaneous.		Optional	
testing	speed	is	defined	in	Specified	Speed.		This	test	can	be	done	in	either	Absolute	or	Incremental	convention,	
optional and defaulted to Absolute.

4) Free Length
 This command is represented by the letter “E” and can only be used for compression tests.  Optional nominal length 

is	defined	in	Specified	Length,	optional	tolerance	is	defined	in	Specified	Tolerance,	and	optional	testing	speed	is	
defined	in	Specified	Speed.		This	test	can	only	be	performed	in	Absolute	convention.

5) Peak Force
	 This	command	is	represented	by	the	letter	“K”.		Testing	length	is	defined	in	Specified	Length.		Optional	nominal	

force	is	defined	in	Specified	Force,	optional	tolerance	is	defined	in	Specified	Tolerance,	testing	speed	is	defined	in	
Specified	Speed.		This	test	can	only	be	performed	in	Absolute	convention.

6) Rate
	 This	command	is	represented	by	the	letter	“R”.		The	first	test	point	is	defined	in	Specified	Length,	the	second	test	

point	is	defined	in	Specified	Force,	optional	nominal	rate	is	defined	in	Specified	Miscellaneous,	optional	tolerance	
is	defined	in	Specified	Tolerance.

7) Pause
	 This	command	is	represented	by	the	letter	“A”.		This	command	accepts	no	other	specification.
8) Delay
	 This	command	is	represented	by	the	letter	“D”.		Delay	time	is	specified	in	Specified	Miscellaneous	and	is	in	the	form	

MMSS.S.		Seconds	of	delay	are	defined	in	the	tens,	ones,	and	tenths	position	and	minutes	of	display	are	in	the	
hundreds	and	thousands	position.		Example,	a	Specified	Miscellaneous	of	1025.5	would	be	10	minutes	and	25.5	
seconds of delay.

9) Initial Tension
	 This	command	is	represented	by	the	letter	“I”	and	can	only	be	used	for	extension	tests.		Deflection	length	is	defined	

in	Specified	Length,	optional	Nominal	tension	is	defined	in	Specified	Force,	optional	tolerance	is	defined	in	Specified	
Tolerance,	 optional	 testing	 speed	 is	 defined	 in	Specified	Speed.	 	This	 test	 can	only	 be	performed	 in	Absolute	
convention.

3.3.4.8.2.2  Interactive Mode Commands
The	remaining	16	command	are	for	Interactive	Mode	testing.		Most	of	the	specification	for	Interactive	mode	testing	can	
be	given	as	constants,	variables,	or	results	from	other	test	points.		For	these	specifications	the	specified	number	will	be	
preceded by either a “C” for a constant number, a “V” for a variable name, or an “R” for the results of a test point.

The	following	list	will	explain	the	interactive	tests	and	what	each	specification	is	used	for.

1) If-Then-Goto Statement.
 This command is represented by the letter “H”. This command will compare two items and will either proceed to the 

next	test	point	if	the	comparison	is	false	or	will	go	to	the	specified	test	point	if	the	comparison	is	true.		The	format	of	
the	logic	is	:	If	X	a	Y	then	goto	test	point	Z.		“X”	is	stored	in	the	Specified	Speed	and	can	be	defined	as	a	constant,	a	
variable,	or	a	result.		An	example	of	the	syntax	would	be	“SS|C1”	which	represents	a	constant	of	1.		“a”	represents	
the	comparison	and	is	stored	in	the	Specified	Length.		Greater	than	(>)	is	a	0,	Less	than	(<)	is	a	1,	Equal	to	(=)	is	a	
2,		does	not	equal	(<>)	is	a	3,	Greater	than	or	equal	to	(>=)	is	a	4,	and	Less	than	or	equal	to	(<=)	is	a	5.		An	example	
of	the	syntax	would	be	“SL|1”	which	would	be	Less	than.		“Y”	is	stored	in	Specified	Force	and	is	similar	to	“X”.		“Z”	
is	stored	in	Specified	Miscellaneous	and	is	also	similar	to	“X”

2) Goto Test Point.
	 This	command	is	represented	by	the	letter	“G”.		This	command	will	force	the	program	to	proceed	to	the	specified	

test	point.		The	specified	test	point	can	be	given	as	a	constant,	a	variable,	or	a	test	point	result.		The	test	point	to	go	
to	is	in	the	Specified	Miscellaneous.		An	example	of	the	syntax	would	be	“SM|VA”	which	represents	a	variable	called	
A.
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3) Calculate Variable
 This command is represented by the letter “C”.  This command can perform a mathematical operation using constants, 

variables	and	results	from	other	test	points.		The	calculation	is	stored	in	the	Specified	Length.		An	example	syntax	
would	be	“SL|A	=	A+2*#2”.

4) Variable Tolerance
 This command is represented by the letter “V”.  This command will generate Bad Low/Good/Bad High conditions 

based	on	the	specification.		The	result	that	will	have	a	tolerance	applied	to	it	is	stored	in	Specified	Speed	and	can	
be	specified	as	a	constant,	a	variable,	or	a	test	point	result.		An	example	of	the	syntax	is	“SS|R1”	which	represents	
result	of	test	point	1.		The	nominal	value	that	the	result	will	be	compared	to	is	stored	in	Specified	Length.		It	also	can	
be	specified	as	a	constant,	a	variable,	or	a	test	point	result.		An	example	of	this	syntax	is	“SLA”	which	represents	a	
variable	called	A.		The	tolerance	that	will	be	applied	to	the	result	is	stored	in	Specified	Tolerance	and	can	be	specified	
as	a	constant,	a	variable,	or	a	test	point	result.		An	example	of	the	syntax	is	“ST|c12”	which	represents	constant	12.		
The	tolerance	can	be	expressed	as	a	percentage	(X%)	or	in	whole	units	(+/-	X).		This	is	also	stored	in	Specified	
Tolerance and is represented as the case of the letters “C”, “V” or “R”.  Small case letters represent whole units (+/-
X) and upper case letters represent percentage (X%).  The previous example would then be +/- constant 12 units.

5) Set Variable
	 This	command	is	represented	by	the	letter	“X”.		This	command	will	set	a	variable	to	the	specified	data.		The	variable	

name	is	stored	in	the	Specified	Speed	and	is	preceded	by	a	“V”.		An	example	of	the	syntax	would	be	“SS|VAVar”	
which	would	access	a	variable	called	AVar.		The	data	that	the	variable	will	be	set	to	is	stored	in	the	Specified	Length	
and	can	be	a	constant,	a	variable,	or	a	results	of	a	test	point.		An	example	of	the	syntax	would	be	“SL|R3”	which	
represents the result of test point 3.

6) Read Keyboard
 This command is represented by the letter “B”.  This command will allow the user to input either a number or text 

through the keyboard.  If a number is entered a nominal value and a tolerance can be applied to it.  Units can also 
be	supplied	for	the	entered	result.		A	user	defined	message	can	be	shown	to	the	user	to	prompt	them	to	enter	data.		
The	Numeric	or	Text	entry	option	and	the	user	defined	prompt	are	stored	in	the	Spec	Miscellaneous.		The	syntax	is	
“SM|Yprompt”	where	“Y”	is	either	an	“N”	for	a	numeric	entry	or	a	“T”	for	a	text	entry.		“prompt”	is	the	user	supplied	
prompt.		The	nominal	value	for	a	numeric	entry	is	stored	in	the	Specified	Length.		The	nominal	value	can	be	either	a	
constant,	a	variable,	or	the	result	of	a	test	point.		An	example	of	the	syntax	is	“SL|C3.2”	which	represents	a	constant	
of	3.2.		The	tolerance	applied	to	the	entered	number	is	stored	in	the	Specified	Tolerance	and	can	be	either	a	constant,	
a	variable,	or	the	results	of	a	test	point.		An	example	of	the	syntax	is	“ST|VAVar”	which	represents	a	variable	named	
AVar.		The	tolerance	can	be	expressed	as	a	percentage	(X%)	or	in	whole	units	(+/-	X).		This	is	also	stored	in	Specified	
Tolerance and is represented as the case of the letters “C”, “V” or “R”.  Lower case letters represent whole units (+/-X) 
and upper case letters represent percentage (X%).  The units that are applied to a numeric results are represented 
in	the	Specified	Force.		The	syntax	is	“SF|X”	where	“X”	is	either	an	“L”	for	Length	Units,	an	“F”	for	force	units,	an	“N”	
for no units or an “Oxxxx” for other units and the “xxxx” is a user supplied unit.

7) Read Serial Port
 This command is represented by the letter “Y”.  This command will allow the UTM to get information from a device 

through RS232.  A nominal value and tolerance can be entered and units can be applied to the reading.  The 
delineation for the incoming RS232 data can be set along with what serial port is used.  The nominal value is set in 
Specified	Length	and	can	be	either	a	constant,	a	variable,	or	the	result	of	a	test	point.		An	example	syntax	is	“SL|C2.3”	
and	represents	a	constant	2.3.		The	tolerance	is	stored	in	the	Specified	Tolerance	and	can	also	be	a	constant,	a	
variable, or the result of a test point.  The tolerance can also be stated as a percent or as whole units.  Percentages 
are represented by a upper case “C”, “V”, or “R” and whole units are represented by lower case “c”, “v”, or “r”.  An 
example	syntax	is	“ST|r2”	which	represents	the	results	of	test	point	2	and	in	whole	units.		The	units	assigned	to	the	
result	is	stored	in	Specified	Force	and	is	represented	by	either	an	“L”	length	units,	an	“F”	for	force	units,	an	“N”	for	
no	units,	or	an	“Oxxxx”	for	other	units	and	the	“xxxx”	is	the	user	supplied	units.		An	example	of	the	syntax	is	“SF|L”	
which	represents	length	units.		The	com	port	to	use	is	stored	in	the	Specified	Speed	and	has	the	syntax	“SS|X”	
where	“X”	is	the	com	port	number	to	be	used	and	is	between	1	an	10.		The	delineation	used	is	stored	in	the	Specified	
Miscellaneous	and	has	the	syntax	“SM|xx”	where	xx	represents	the	delineation.		The	delineations	that	can	be	used	
are a “C” for a comma, an “S” for a space character, a “T” for a tab character, an “e” for a semicolon, an “a” for a 
carriage	return,	a	“D”	for	a	decimal	point,	an	“lx.x”	(lower	case	“L”)	for	a	delay	of	x.x	seconds,	or	an	“Fx”	for	fixed	
fields	of	x	characters.

8) Test Point Comments
	 This	command	is	represented	by	the	letter	“M”.		This	command	will	display	a	user	defined	comment.		This	command	

can	be	set	to	be	displayed	until	the	next	test	point	is	finished	or	until	the	operator	acknowledges	the	comment.		The	
comment	is	set	in	Specified	Length	and	has	the	syntax	“SL|comment”	where	“comment”	is	the	user	defined	comment.		
The	continue	or	wait	selection	is	in	Specified	Speed	and	the	syntax	is	“SS|X”	where	X	will	be	either	a	“1”	to	wait	for	
the user to acknowledge or a “0” to continue the test.
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9) Sorter Output
 This command is represented by the letter “S”.  This command will force the connected UT tester to generate a 

sorting	signal	for	a	defined	amount	of	time	expressed	in	seconds.		The	sorting	signal	to	be	forced	is	in	the	Specified	
Speed	and	the	syntax	is	“SS|x”	where	X	is	a	number	between	0	and	31.		The	defined	amount	of	time	is	in	Specified	
Length	and	can	be	either	a	constant,	a	variable,	or	the	results	of	a	test	point.		An	example	of	the	syntax	is	“SL|C5.2”	
which represents a constant value of 5.2 seconds.

10) Timer Functions
 This command is represented by the letter “T”.  This command allow various functions to be done to the timer.  If a 

specific	time	is	being	set	or	waited	for	it	is	in	Specified	Length	and	can	be	either	a	constant,	a	variable,	or	the	result	
of	a	test	point.		An	example	of	the	syntax	is	“SL|VTimeVar”	which	represents	a	variable	called	TimeVar.		The	action	
of	the	timer	is	specified	in	Specified	Speed	and	has	the	syntax	“SS|x”	where	x	will	be	either	“s”	for	set	timer,	“S”	for	
start	timer,	“o”	for	stop	timer,	or	“W”	for	wait	until	timer	is.		The	direction	of	the	timer	is	set	in	Specified	Force	and	has	
the	syntax	“SF|y”	where	“y”	is	either	“U”	for	counting	up	or	“D”	for	counting	down.

11) Larson TST
 This command is represented by the letter “W”.  This command allows communication to a Larson Torsion Spring 

Tester.  This command must specify the com port the TST is connected to, a reading from the TST to read, and 
whether the test point waits for new data or uses previously sent data.  A nominal value and a tolerance are optional.  
The	com	port	used	is	stored	in	Specified	Miscellaneous	and	the	syntax	in	“SM|X”	where	“X”	is	a	number	between	1	
and	10	representing	the	com	port	the	TST	is	connected	to.		What	to	measure	is	stored	in	Specified	Speed	and	the	
syntax	is	“SS|z”	where	“z”	is	a	letter	that	represents	what	to	measure.		“z”	can	be	one	of	the	following:	

“A” for manual mode length, 
“B” for manual mode force, 
“C” for peak mode length, 
“D” for peak mode force, 
“N”	for	two	point	with	rate	first	point	length,	
“O”	for	two	point	with	rate	first	point	force,	
“P” for two point with rate second point length, 
“Q” for two point with rate second point force, 
“R” for two point with rate mode rate, 
“S”	for	first	peak	length,	or	
“T”	for	first	peak	force.		

	 Whether	to	wait	for	new	data	or	used	previously	sent	data	is	stored	in	Specified	Absolute/Incremental	and	has	the	
syntax	“SI|x”	where	x	is	“I”	to	wait	for	new	data	or	“A”	to	use	previously	sent	data.		The	optional	nominal	value	is	
stored	in	Specified	Length.		It	can	be	given	as	a	constant,	a	variable,	or	the	result	of	a	test	point.		An	example	syntax	
is	“SL|C12.3”	which	represents	a	constant	value	of	12.3.		The	optional	tolerance	is	stored	in	Specified	Tolerance	and	
can	also	be	represented	by	a	constant,	a	variable,	or	the	results	of	a	test	point.		It	can	also	be	specified	in	percentage	
or	as	whole	units.		An	example	of	the	syntax	is	“ST|r4”	which	represents	a	tolerance	of	+/-	the	result	of	test	point	
4 and is in whole units.  The “r” in the example represents the results of a test point and the case of the character, 
lower in the example, represents whole units.  An upper case “R” would have represented a percentage.

12) Larson Super DHT
 This command is represented by the letter “U”.  This command allows communication to a Larson Super DHT Tester.  

This command must specify the com port the Super DHT is connected to, a reading from the Super DHT to read, 
and whether the test point waits for new data from the tester or uses previously sent data.  A nominal value and a 
tolerance	are	optional.		The	com	port	used	is	stored	in	Specified	Miscellaneous	and	the	syntax	is	“SM|X”	where	“X”	
is a number between 1 and 10 representing the com port the Super DHT is connected to.  What to measure is stored 
in	Specified	Speed	and	the	syntax	is	“SS|z”	where	“z’	is	a	letter	that	represents	what	to	measure.		“z”	can	be	one	of	
the following : 

“A” for manual mode length, 
“B” for manual mode force,
“C” for peak mode length, 
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“D” for peak mode force, 
“E” for contact mode free length, 
“F”	for	contact	mode	first	point	length,	
“G”	for	contact	mode	first	point	force,	
“H” for contact mode second point length, 
“I” for contact mode second point force, 
“J” for contact mode third point length, 
“K” for contact mode third point force, 
“L” for contact mode fourth point length,
“M” for contact mode fourth point force,
“N”	for	two	point	with	rate	first	point	length,
“O”	for	two	point	with	rate	first	point	force,
“P” for two point with rate second point length,
“Q” for two point with rate second point force,
“R” for two point with rate rate,
“S”	for	first	peak	mode	length,	or
“T”	for	first	peak	mode	force.

	 Whether	to	wait	for	new	data	or	used	previously	sent	data	is	stored	in	Specified	Absolute/Incremental	and	has	the	
syntax	“SI|x”	where	x	is	“I”	to	wait	for	new	data	or	“A”	to	use	previously	sent	data.		The	optional	nominal	value	is	
stored	in	Specified	Length.		It	can	be	given	as	a	constant,	a	variable,	or	the	result	of	a	test	point.		An	example	syntax	
is	“SL|C12.3”	which	represents	a	constant	value	of	12.3.		The	optional	tolerance	is	stored	in	Specified	Tolerance	and	
can	also	be	represented	by	a	constant,	a	variable,	or	the	result	of	a	test	point.		It	can	also	be	specified	in	percentage	
or	as	whole	units.		An	example	of	the	syntax	is	“ST|r4”	which	represents	a	tolerance	of	+/-	the	result	of	test	point	
4 and is in whole units.  The lower case “r” in the example represents tolerance in whole units.  An upper case “R” 
would have represented a percentage.

13) Larson ST/MST
 This command is currently not set up to be programmed through Spreadsheet DDE.
14) Larson DHT/CDHT

This command is represented by the letter “N”.  This command allows communication with a Larson DHT or a 
CDHT	tester	through	RS232.		The	comm.	Port	that	this	command	will	use	is	specified	in	Specified	Speed	and	
has	the	syntax	“SS|x”	where	“x”	is	a	number	between	1	and	10	representing	the	comm.	Port	that	will	be	used.		An	
optional	nominal	value	can	be	defined	and	is	specified	in	the	Specified	Length.		It	can	be	specified	as	a	constant,	
a	variable,	or	the	result	of	another	test	point.		An	example	of	the	syntax	is	“SL|C1.23”	which	represents	a	constant	
value	of	1.23.		An	optional	tolerance	can	also	be	entered.		The	tolerance	is	specified	in	the	Specified	Tolerance	
and	can	be	specified	as	a	constant,	a	variable,	or	the	result	of	a	test	point.		It	can	also	be	specified	as	a	percent-
age	or	a	whole	number.		And	example	of	the	syntax	is	“ST|R3”	which	represents	the	result	of	test	point	4	used	
as a percentage.  The upper case “R” is for percentage where a lower case “r” would have represented a whole 
number.  Newer DHTs can also send out Length data.  This command can also read the length from these testers.  
The	value	to	read	is	specified	in	the	Specified	Miscellaneous	and	has	the	syntax	“SM|x”	where	“x”	is	either	a	1	for	
Force	readings	or	a	0	for	Length	readings.		The	Specified	Force	also	needs	to	be	set	to	specify	what	to	read	and	
has	the	Syntax	“SF|x”	where	“x”	is	either	“F”	for	force	readings	or	“L”	for	length	readings.		Since	the	new	testers	
can	send	out	two	pieces	of	data	this	command	can	be	used	to	read	both	first	and	second	pieces	of	data	by	having	
one command wait for new data and the other use the previous data.  To specify the command to wait for new 
data	the	Specified	Absolute/Incremental	setting	is	set	to	a	1,	the	syntax	is	“SI|I”	(letter	i’s).		To	specify	the	com-
mand	to	use	the	previous	data	use	the	syntax	“SI|A”

15) Larson TWCS
 This command is represented by the letter “O”.  This command allow communication with a Larson Torque Wrench 

Calibration	System	through	RS232..	The	serial	port	that	is	to	be	used	is	specified	in	Specified	Speed	and	has	the	
syntax	“SS|x”	where	“x”	is	a	number	between	1	and	10	that	represents	the	com	port	that	the	TWCS	is	connected	to.		
An	option	nominal	force	can	be	specified	and	is	specified	in	Specified	Length.		It	can	be	specified	as	a	constant,	a	
variable,	or	the	result	of	a	test	point.		An	example	of	the	syntax	is	“SL|C12”	and	represents	a	constant	value	of	12.		
An	optional	tolerance	is	specified	in	the	Specified	Tolerance	and	the	syntax	is	similar	to	the	nominal	value	entry.		The	
tolerance	can	be	specified	as	either	a	percentage	or	a	whole	number.		The	case	of	the	letters	“C”,	“V”,	or	“R”	in	the	
syntax	represents	how	the	tolerance	is	defined.		An	upper	case	“C”,	“V”,	or	“R”	represents	a	percentage	number,	a	
lower case “c”, “v”, or “r” represents a whole number.

16) Larson Super TWCS
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	 The	Larson	STWCS	is	set	up	similar	to	the	Larson	SDHT,	#12.		The	difference	is	in	the	Specified	Speed	setting,	
what data to read.  The STWCS can send only Manual Force, “B”, Peak Force, “D”, or First Peak Force, “T”.

17) End Test
	 This	command	is	represented	by	the	letter	“J”	and	has	no	other	specifications.		This	command	is	used	to	end	the	

testing sequence before the end of the sequence is encountered.

3.3.5  Miscellaneous
From the Miscellaneous item under the Options menu item there are 5 other option you can set.

First,	you	can	have	results	sent	automatically	to	a	printer	as	they	come	in.		This	can	be	specified	for	each		port	separately.

Second,	you	can	specify	what	is	printed	on	the	first	two	lines	of	the	printouts,	typically	it	is	your	company	name	and	city.

Third, you can specify what is displayed in the title bar of the UTM program itself.  This may be comments about what 
devices are connected to the UTM.

Fourth is how many lines per page will be printed out.  You can increase or decrease this as you like.  Decreasing this 
number will leave white space on the bottom of some of the longer printouts.

Lastly is how many standard deviations will be used 
for control limits.  This number is typically 3 but can be 
set to anything from 1 to 9.

Click	OK	when	you	are	finished	specifying	these	op-
tions.

3.3.6  Excel Template
The UTM 3.12 shipped with a UTM template that mim-
ics many of the features the UTM has.  This template 
does contain macros and Excel may ask you if you want 
these macro enables.  Larson does hope you consider 
us a trusted source for the macros.  The macros are 
coded in the Visual Basic Script language.

These macros are not protected.  They are open to 
inspection and alteration.  Larson Systems will hold 
no liability if these macros are altered.  It is advisable 
that at least one copy is saved in a secure location as 
a backup.

When you choose the Launch Excel Macro from the 
Options	menu	the	UTM	will	try	to	start	Microsoft	Excel.		If	the	UTM	cannot	find	the	Excel.exe	program	it	will	ask	you	to	
find	it.		The	UTM	will	try	to	start	Excel	with	the	UTM	Template.		If	the	UTM	cannot	find	the	“UTM	Template.xls”	program	
you	will	have	to	find	it.		It	should	have	been	installed	in	the	same	directory	as	the	UTM	program	itself.
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The	UTM	Template	will	load	data	from	any	UTM	result	file.		The	corresponding	Specification	file	must	be	present	in	the	
same directory for various features to work.  The Template will automatically calculate statistics and can create similar 
graphics as the UTM.

If you want features that the UTM does not have you can alter the UTM Template to create them.

3.3.7  Demos
The UTM comes with 6 interactive demos.  These demos are here to help explain various features of the UTM.  To start 
any of the demos select the Options menu item, highlight the Run Demo item and another list will be presented next to 
the main Option list.  Select one of these 6 demos and it will start.

The demos consist of an explanation window that will feature comments and explanations.  From this window you can 
use the Next and Back window to scroll through the entire demo.  Most of the demos will load a Demo program and 
results	that	should	be	in	the	same	directory	as	the	UTM	program.		If	the	UTM	cannot	find	these	files	the	demos	will	not	
work properly.  As the demos proceed they will open various result windows and graphics and explain what they are.

It is suggested that you take a few minutes and got through each demo.

3.3.8  About
When you choose the About selection from the Option menu a small window will open up and will give the UTM revision 
number and Larson Systems address and phone number.  If you have any questions about how the UTM works please 
feel free to call us.

3.4  Reading Tester Specs
Reading	tester	specs	allows	you	to	load	specification	from	your	UT	or	ST	tester.		This	is	useful	if	you	have	made	slight	
modifications	to	your	test	after	you	have	downloaded	it	to	your	tester.

There	are	two	ways	to	read	the	tester.		The	first	is	to	use	the	Read	button	in	the	button	bar	(the	button	with	an	arrow	
pointing away from a UT).  The second is to use the Read Tester Spec item under the File menu.

This	will	load	all	of	the	specification	from	the	tester	including	the	testers	maximum	length	and	force,	current	units,	set-
tings for Options 1 and 2, and sort table.
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3.5  Getting Results
3.5.1  Batch Mode
If you are in UT or ST Batch mode, before you can 
get	results	you	must	first	download	the	program	to	the	
tester.  To do this either click the download button in 
the button bar (the button with an arrow pointing to the 
UT) or select the Send item form the File menu item.

Once the test program is loaded into the tester it can 
begin	to	test	parts.		When	the	test	finishes	it	will	send	
the data to the UTM.  If the Up-To-Date option is turned 
on (see Result Options, section 3.3.2) the Actual Re-
sults, Individual and Statistics, Individual windows will 
be shown and updated with the new data.

After you have tested all the parts you want press the Mode button on the tester.  This will signal the end of a Set.  When 
you	save	the	results	each	Set	will	be	saved	in	its	own	file.		Multiple	sets	can	be	in	the	UTM’s	memory	at	one	time.		The	
Set number of the currently display results is at the bottom of the Actual Results, Individual window along with the cur-
rently displayed test number.  You can use the Up/Down arrows or the text boxes to move between test and sets.
Before you save results you have to ability of Tagging tests.  When you Tag a test you remove it from the statistics and 
graphics.  You can give a reason in a comment box as to why you tagged the test.  To Tag a test use the Up/Down arrow 
for	the	Set	and	Test	Points	in	the	Actual	Results,	Individual	window	and	find	the	test	you	want	removed.		In	the	upper	part	
of the Actual Results window is a button labeled Tag.  Click this button and the Tag Reason comment window appears.  
Type in the reason why this test was tagged and press OK.  That test is now removed from all statistics and graphics.

If you have Tagged a test but want it back into consideration click the UnTag button.  This will remove the Tag Reason 
and let the test be part of the statistics and graphics.

Once the Set is save to disk tests cannot be Tagged or UnTagged.

When you have tagged or untagged all the tests you want, save the results.  To do this either click the Save Button on 
the	button	bar	(the	button	with	an	arrow	pointing	to	a	floppy	disk)	or	select	Save	from	the	File	menu.

3.5.2  Interactive Mode.
After you have programmed in an interactive test you can start the test one of three ways: by starting one full test, start 
stepping through the program, or by starting a continuous loop.

When no test is being conducted the button with the red stop light will be highlighted with a bright blue background.  
When you click one of the other buttons it will become highlighted with the bright blue background and the red light will 
have the normal background.

The green stoplight is used to start one full test.  The test sequence will go through all of the test points and display the 
results	when	it	is	finished.
To step though the test click on the button with the footprints in it.  This will force one and only one test point to be tested.  
When	that	test	point	is	finished	the	test	will	pause	and	you	will	be	prompted	to	press	the	Step	button	again	to	test	the	
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next	test	point.		When	all	tests	points	are	finished	the	results	will	be	displayed.

The button with the two blue arrows pointing to each other represents a continuous loop.  When one test sequence is 
finished	the	results	are	displayed	and	another	test	is	automatically	started.		You	must	press	the	red	stop	light	to	break	
the continuous loop.

Once the results are gathered you have the option of tagging or untagging tests from the Actual Results, Individual window.

When you have tagged or untagged all the tests desired save the data.  Once the data is saved the Set ends and no 
more tagging or untagging is allowed.  Saving data is the only way to end a Set in Interactive mode.

3.5.3  Saving Results
To	save	data	to	the	disk	either	press	the	save	button	in	the	button	bar	(the	button	with	an	arrow	pointing	to	a	floppy	disk)	
or select Save from the File menu when results are in the UTM’s memory.

Results	are	saved	with	the	same	file	name	as	the	specifications	but	with	numerical	extensions.		The	extensions	start	
with	.001	and	will	continue	to	.999.		The	UTM	will	try	to	save	the	results	with	the	lowest	number.		It	will	fill	in	holes	in	the	
numerical	sequence	if	there	are	any,	i.e.	if	a	directory	contains	the	files	Part.001	and	Part.003	and	new	data	is	save	to	
the	Part	file	it	will	be	save	with	the	name	Part.002.		From	the	File	Open	window	you	can	sort	all	of	the	files	in	the	direc-
tory	by	either	name	or	date	modified.		If	you	sort	by	date	modified	you	will	be	able	to	see	if	such	a	hole	has	been	filled.

3.5.4  Loading Results
When data has been saved to a disk it can then be retrieved.  To load data either click on the File Open button in the 
button bar (the button with an arrow pointing away from a disk) or use the Open command from the File menu.  You can 
load	multiple	result	files	at	one	time.		If	files	with	different	names	are	selected	only	one	of	those	names	are	used	to	load	
the	files.		The	UTM	cannot	load	different	files	into	its	
memory.  The File Open window will accept multiple, 
disconnected selections.

When you load data you will be asked where new data 
should be located.  Your choices are to save new data 
in	new	sets	and	new	files,	continue	to	add	new	data	to	
an	existing	set	creating	an	increasing	larger	file,	or	to	
defer the question until new data is gathered.  This set 
of choices can also be changed at any time after results 
are brought into memory by selecting the Save Options 
item under the File Menu.

3.5.5  Clearing Results
To remove all results from memory but retain the test 
select Clear Results from the Results menu.  If there 
are no results in memory the Clear Results item is not 
shown in the Results menu.
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3.6  Viewing Results
Once results have been brought into the UTM, either by loading results or performing tests, different types of data can 
be viewed.

3.6.1  Individual Actual Results
With Individual results you can view every test point result for every test.  You can view the Actual data by selecting 
Actual Data from the Individual item under the Results menu item.  This window will display all the test point results for 
one test.  You can maneuver from test to test by using either the Up/Down arrow or text box for Test Points.  You can 
use the Test Point arrows to maneuver between Sets or you can use the Up/Down arrows and text box for Sets on the 
very bottom of the Actual Data window.
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3.6.2  Individual Statistics
Statistics show how the Set of data has behaved.  It contains the 
mean, range, standard deviation, CP, CpK, and other things.  To 
view this window select Statistics from the Individual item under 
the Results menu item.  The statistics displayed are for current Set 
selected from the Individual Results window.

3.6.3  F Vs L Graph
If you have UT test points in either UT Batch or Interactive Mode you 
can view a F Vs L graph.  Only certain UT commands will generate 
both force and length data.  Only from these certain commands can 
data be entered into a F Vs L graph.  To view this graph select F Vs 
L Graph from the Individuals item under the Results menu.

This graph plots Force Vs Length for each of the test points that have 
the necessary force and length data.  They are plotted in the order 
they	were	defined	in.		If	a	part	is	supposed	to	have	hysteresis	it	will	
be shown in this graph.  Hysteresis is where spring rate of a part is 
different from increasing force to decreasing force.

By clicking on the Options button on the F Vs L graph you can change how the graph looks.  First you can zoom into or 
out of a plot.  To do this, change the minimum and maximum scale values. 

The UTM generates a default Graph Title.  You have the option of changing this title.  It will appear on any printouts.
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You can change how many lines are displayed on the graph, 
both for the length and force axis.

The	graph	can	either	be	connected	lines	without	specification	
limits or unconnected dots that represent the result data, the 
upper	and	lower	specification	limits	for	each	point.

Click on any point in the graph to display a small information 
window that will display the actual value, the values of any 
specification,	mean,	or	control	line,	and	the	condition	of	the	point.		
Click anywhere else on the graph to remove this information box.
3.6.4  Individual Test Point Graph.
The Individual Graph will display the results of one test point 
across all of the tests in a Set.  This will show how that one test 
point varies over the Set.  To view this graph select Individual Test 
Point Graph from the Individuals item under the Result menu.

Below the graph is the Zoom In and Zoom Out buttons and a 
scroll bar.  When you Zoom In to a graph you are changing the 
maximum number of tests that are displayed in the x-axis to 
roughly half of what is currently is.  Once you have zoomed into 
the graph you can use the scroll bar to change the minimum x-
axis value thereby changing to a different group of tests being 
displayed.  The Zoom In button will work until there are only two 
points being displayed.  You can then use the Zoom Out button 
to display more tests on the graph.  The Zoom Out button will stop working once all the tests are being displayed on 
the Graph.

To	change	what	test	point	results	are	being	viewed	select	a	different	test	point	from	the	Test	Specification	window.		To	
change what Set is being view select a different Set from the Actual Results, Individual window.

To	change	other	parts	of	the	graph	click	the	Option	button	in	the	graph	window.		The	first	option	in	the	Option	window	is	
the maximum number of labels.  Changing this changed the number of ticks on the x-axis.  This will put more or fewer 
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labels on the graph.  If there are too many labels on the graph you will not 
be able to distinguish between them.

Vertical lines can be extended from each tick mark on the x-axis.  To show 
these, check the Vertical Lines check box.
Specification	lines,	the	mean	line	and	+/-	3	Sigma	control	lines	can	also	be	
displayed by checking the appropriate option.  You can zoom into the y-axis 
by changing the maximum and minimum limits in this window.
You can also change the graph title from the UTM generated default.  This 
title will appear on the printout.
When you change any option you can click Update to apply these changed 
options to the graph and leave the Option window open.  When you click 
OK the changes are applied and the Option window is closed.

Click on any point in the graph to display a small information window that 
will	display	the	actual	value,	the	values	of	any	specification,	mean,	or	control	
line, and the condition of the point.  Click anywhere else on the graph to 
remove this information box.

3.6.5  Lot Actual Results
A Lot of data is a predetermined number of individual tests that are grouped 
together.  The result of this grouping is a mean value for all of the individual 
test points in the group.  The number of tests in a lot is controlled from the Results item under the Options menu (Sec-
tion 3.3.2).  The Lot Size can be changed at any time since the resultant means are based on the Individual results, 
and these cannot be changed once they are in the UTM (they can, however, be Tagged if the set has not been saved 
or was not retrieved from memory).

To see the Actual Data, Lot select Actual Data from the Lot item under the Results menu.  This will bring up the Actual 
Data,	Lot	window.		From	here	you	can	view	the	mean	data	from	the	lot	grouping.		The	grouping	will	start	with	the	first	
result	from	the	first	set	and	continue	to	the	last	result	of	the	last	set.		If	the	number	of	results	in	a	set	is	not	a	multiple	of	
the Lot size then results from one set will be combined with the results from a different set.  If the number of results in 
all of the sets is a multiple of the Lot size no Set overlapping will occur.

3.6.6  Lot Statistics
The statistics for the Lot data consist of the same statistic categories as the Individual Statistics.  To see these statistics 
select Statistics from the Lot item under the Results menu.
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3.6.7  Histogram
The Histogram applies only to Lot data.  It shows the distribution of all 
the data based on the minimum and maximum reading.  The number of 
categories is controlled from an option within the Option window for the 
Histogram.  The Histogram graph also shows a normal line that shows 
if the data is evenly distributed or if it is loaded to one side of another.

To view the Histogram, select the Histogram item from the Lot selec-
tion under the Results menu.

To change other parts of the Histogram click the Options button from 
the graph window..

Maximum Number of Frequency Labels Displayed controls the y-axis 
labels,	these	show	how	many	tests	fall	into	a	specific	range	of	values.

Number of Bars controls how many ranges of values between the mini-
mum and maximum values there are, these are displayed on the x-axis.

You have to option change the default title for the histogram.  This title will appear on the printout.

Click	OK	when	you	are	finished	changing	the	options.
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3.6.8  X-Bar Graph
An X-Bar graph is similar to the Individual Test Point but uses the Lot data.  To view the X-Bar graph select X-Bar Graph 
from the Lot item under the Results Menu.

To change what test point is being viewed select a different 
test	point	from	the	Test	Specifications	window.

Below the graph are Zoom In and Zoom Out buttons.  Use 
these buttons to decrease or increase the number of lots 
displayed in the graph.  Once you have zoomed in use the 
scroll bar to shift to different groups of lots.  You can zoom 
into the graph until two points are shown and you can zoom 
out only until all of the lots are displayed.

To change other parts of the graph click the Option button 
to see other options you can change.  Since the R-Chart is 
closely related to the X-Bar graph, options for the R-Chart 
are within this Option window.  They can only be accessed if the R-Chart is being viewed.

There are three options that are for both X-Bar Graphs and R-Charts.  You can have vertical lines on both, display control 
limits on both, and synchronize them to each other.  Control limits are based on an Estimated 3 Sigma formula.  When 
you synchronize the X-Bar and R graphs they become the same width, same height, and the X-Bar graph is shown 
above the R-Chart.  From this view each point in the X-Bar graph lines up with its corresponding point in the R-Chart.

For	the	X-Bar	graph	you	can	also	see	the	Specification	limits	and	an	X-Double	Bar	line,	the	mean	of	all	the	means	plotted.
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You can zoom into the y-axis by specifying 
maximum and minimum limits and change 
the default graph title by specifying a new 
title.  This title will appear on the print out.

Click Update to view the changed options 
without closing the Options window or click 
OK to enable the changes and close the 
Options window.

Click on any point in the graph to display a 
small information window that will display 
the	actual	value,	the	values	of	any	specifi-
cation, mean, or control line, and the condi-
tion of the point.  Click anywhere else on 
the graph to remove this information box.
3.6.9  Range Graph (R-Chart)
A Range graph displays the range of values 
within one lot; this shows how variable the 
data is within the lot.  To view the Range Graph select R Chart from the Lot item under the Results menu.

Below the Graph itself are a Zoom In and a Zoom out button.  With these buttons you can reduce the number of lots 
displayed on the graph, this will allow you to view a section of the graph in more detail.  Once you Zoom in a scroll bar 
will appear to allow you to move between sections of the graph.  You can Zoom In until only two points are displayed 
and you can Zoom Out only until all points are displayed.

To view the control options for the R-Chart click on the Options button above the graph.

Because the X-Bar and R-Chart graph are closely related three options are shared with the X-Bar graph.  Vertical lines 
are display from each tick mark on the x-axis, which represents each lot.  Control lines can be viewed with the data.  
Control lines are based on an Estimated 3 Sigma formula.  The X-Bar and R-Chart graphs can be synchronized.  This 
means that the graphs become the same width and height and are horizontally aligned with each other.  The X-Bar graph 
is displayed above the R-Chart.  When one is moved or resized the other is similarly moved and resized.

There are three options that pertain only to the R-Chart.  The Range Mean line shows the average of all the Ranges.  
You can zoom into the y-axis by changing the y-axis minimum and maximum.  You can also change the default R-Chart 
title.  This title appears on the printout. 

When	you	are	finished	changing	any	of	the	options	click	Update	to	view	the	changes	without	closing	the	Options	window	
or OK to enable the changes and close the Options window.
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Click on any point in the graph to display a small information window that will display the actual value, the values of 
any	specification,	mean,	or	control	line,	and	the	
condition of the point.  Click anywhere else on 
the graph to remove this information box.
3.6.10  Moving Average Graph.
The Moving Average Graph shows trends over 
a group of lots by averaging together a certain 
number of Lots then moving one Lot down and 
averaging together another group.  Example, it 
the moving size is 5 Lots 1 to 5 are averaged 
and plotted for location 5, then Lots 2 to 6 are 
averaged and plotted for Lot 6, 3 to 7 for 7, 4 to 8 
for 8, and so on.  This method tends to dampen 
out one time spikes in the readings.

To view the options available for the Moving 
Average Graph click on the Options button 
above the graph.  Vertical lines can be shown 
from each of the tick marks on the x-axis, the 
Lot Number line.  Control limits can be view 
with the plot.  Control limits come from an Estimated 3 sigma formula like the X-Bar and R-Chart.  A Mean line can be 
shown on the plot.  The Mean line is the average of all the points plotted.  The y-axis can be zoomed into by changing 
the y-axis minimum and maximum.  The default graph title can also be changed.  This title appears on the printout.  The 
Moving Group size can be changed from here.  This controls how many Lots are grouped together for each point plotted. 

When	you	have	finished	changing	any	of	the	options	click	the	Update	button	to	see	the	changes	to	the	graph	without	
closing the Options window or click OK to enable the changes and close the Option window.

Click on any point in the graph to display a small information window that will display the actual value, the values of 
any	specification,	mean,	or	control	line,	and	the	condition	of	the	point.		Click	anywhere	else	on	the	graph	to	remove	this	
information box.

3.7  Printing Results
Every result and graph window has a print button.  Click on any Print button to print out the contents of the particular 
window.		The	text	based	printouts	are	the	Test	Specifications,	the	Sorting	Table,	Individual	Actual	Results,	Individual	
Statistics, Lot Actual, and Lot Statistics.  The graph printouts are the Individual Test Point Graph, the F Vs L graph, the 
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X-Bar graph, the R-Chart, the Histogram, and the Moving Average Graph.

The UTM also has an Overall Print button.  It is the button with a printer symbol 
in it in the button bar.  This button will cause every open window to print.  It is 
a quick way to print out a combination of windows.  The UTM has the ability to 
create	predefined	combinations	of	windows.		See	section	3.8.3,	window	layouts.

3.8  Other Features
3.8.1  Merging Files
If you have a group of results files that you would like to be 
stored as one large file instead of multiple small files the 
UTM has a utility that can merge multiple files into one large 
file.  To start this utility click Merge File under the File menu.

To start you can pick what drive and directory your files 
are in.  When you highlight a specification file from the 
Specifications Files list any result files will be listed in the 
Result Files list.  From the Result Files list you can select all 
of the files you want merged into one.  The Result Files list 
allows multiple and disconnected selections.  Once you have selected all of the files to merge 
together you must select what name to call the merged files.  In order to open the merged files 
you must retain the same name but you can change the numerical extension.  You can choose 
an existing file from the Destination File list or create a new extension from the Destination 
File text box.  When you have selected a destination file you can merge the files together.  To 
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merge the files and stay in the Merge Results File utility click the Merge & Stay button.  To 
merge the files and exit the utility click Merge & Close.  To exit the utility click Cancel.
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3.8.2  Back Up and Restore UT Memory
If you use the UT Memory Save/Retrieve feature the UTM can now read all of the 
memory	location	in	the	UT	and	download	and	save	all	of	those	specifications	onto	
you	computer.		The	UTM	can	also	restore	a	UT	memory	from	specification	files	it	
has on your computer.  The Back Up utility is time consuming; it can take anywhere 
from 10 to 30 minutes depending on how full your UT memory is.

To Back Up your UT select Back Up UT from the File Menu.  You will be asked to 
select a directory to place the UT memory.  The directory must exist to select it; 
you cannot create the directory from the directory selection.  Once you select the 
directory click OK.  To exit the utility without backing up the UT click Cancel.  When 
you click OK to continue you will be asked to verify the directory you want the UT 
memory in.  Any information in that directory may be overwritten with new informa-
tion.  Tests that are in the directory but not in the UT will remain in the directory, i.e. 
if the directory has a test from memory location 5 but there is no test currently in 
location 5 that test will remain in the directory on the computer, if you restore from 
that	directory	the	UT	memory	5	will	be	filled.

To Restore the UT memory select Restore UT Memory from the File menu.  You will be prompted to select a directory 
that contains the tests you want restored to the UT.  Once you have selected the directory click OK to continue.  Click 
Cancel to abort the restore.  Once you have clicked OK you will be asked to verify that the directory you selected is the 
directory you want.  Click OK to continue.  The Restore can be time consuming depending on how many tests are stored 
in the directory.  It is possible for the restore to take up to 30 minutes to restore all 300 possible tests.  The fewer the 
stored tests the faster the restore will proceed. 

3.8.3  Window Layouts
With	Window	Layouts	you	can	select	a	predefined	combination	of	result	windows	to	be	displayed	and	you	can	also	de-
fine	where	each	window	appears.		The	UTM	ships	with	5	layouts	already	in	memory.		The	default	layout	is	Free	Form.		
Free	Form	enforces	no	layouts.		Windows	are	brought	up	in	no	specific	place	and	in	no	particular	combination.		The	
only windows that are automatically shown are the Individual Actual Results and Individual Statistics.  These windows 
are	automatically	brought	up	in	Free	Form	when	the	first	results	of	the	first	set	are	gathered	(by	UT/ST	test	or	Interac-
tive test start).

3.8.3.1  Selecting a Layout
To select any Window Layout click the Layout Button from the button bar, 
it is the button with the generic graphs on it; it is also the farthest button 
to the right in the button bar.  You will be prompted to select a layout from 
the Setup Name drop-down list.  To start the layout click OK, to abort the 
layout click Cancel.  When you click OK and there are results in memory 
the windows selected in the layout will open and be placed in their pre-
determined locations.  If no results are in memory the result windows will 
not be displayed.
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3.8.3.2  Creating/Modifying/Deleting a 
Layout
To	create	a	layout	select	the	Define	Layout	from	the	
Edit Custom Layout item under the Window Menu.  
You can select an existing layout or create a new 
one.  To create a new layout click the Add New 
Layout button.  You will be prompted to give a name 
to this layout.  Click OK to continue the creation.

If you no longer use a layout you can remove it from 
the list.  First select the layout you want removed 
from the Layout name dropdown list.  Next click the 
Remove Old Layout button.  You will be prompted 
to	confirm	the	removal	of	the	layout.		To	finish	the	
removal click OK.  To leave the layout in the list 
click Cancel.

Once you have created a new layout or selected 
an existing layout you can choose what windows 
are opened for the layout.  Do this by checking the 
boxes next to the window name in the Window used 
in current Layout list.

3.8.3.3  Layout Options
There are two options associated with each layout.  If they are enabled they are processed each time the Layout button 
from	the	button	bar	is	clicked.		The	first	is	the	option	to	open	the	File	Open	window.		If	this	option	is	enabled	the	File	
Open window is opened when a new layout is selected. 

The second option is to automatically send batch test or start an Interactive test.  If a test is loaded into memory, either 
by creating it or loading it from memory, the test will be sent to a tester if it is a UT or ST Batch test or the Interactive 
test will be started.

3.8.3.4  Screen Positioning
Once	you	have	a	layout	defined	you	can	determine	where	each	window	will	appear	and	save	that	window	placement.		
You	will	first	have	to	load	results	in	memory	in	order	to	see	the	result	windows.		Do	this	by	either	creating	and	running	a	
test or loading results from memory.

When results are in memory bring up the layout by clicking on the Layout button from the button bar (the far right but-
ton with the graphic symbols in it) and selecting a layout from the list.  The windows in the layout will open up either in 
a default position if it is a new layout or their previously determined position if it is an existing layout.  Position and size 
the windows as you want them

When the windows are in the position you want then click the Arrange Windows item from the Edit Custom Layouts 
under the Windows menu.  You will be prompted to arrange the windows the way you want them.  Click OK to save the 
window placement or Cancel to abort the placement.  If you choose to abort the layout is still saved, the existing place-
ments are simply not changed.

3.8.3.5  Reverting to Free Form
You	can	revert	to	Free	Form	layout	one	of	two	ways.		The	first	is	to	click	on	the	Layout	label	next	to	the	Layout	button	
in the button bar.  The second is to click the Layout button and open the Choose Layout prompt.  Below the drop down 
list is a Free Form check box.  Check this box and the drop down list is disabled and becomes grayed out.  Click OK 
and the Free Form layout is enabled.

No windows are closed, repositioned, or resized when you revert to the Free Form layout.
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